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Introduction to MS Office 

माइक्रोसॉफ्ट ऑफिस (MS Office) दनुिया का सबसे 

Popular Office Suite है Suite का मतलब एक जैसे 

Computer Programs का एक सेट होता है यह 

Program एक दसूरे से Data share कर सकते हैं इिके 

Tools भी लगभग - लगभग एक समाि होते हैं MS Suite 

में ऑफिस में काम आिे वाले सभी Program का एक सेट 

बिाया गया है जजससे आपका Office work और भी आसाि हो जाता है Office में कई प्रकार के कायय होत े

हैं जैसे लेटर बिािा Spreadsheet तैयार करिा, Presentation तैयार करिा, Email  भेजिा, Database 

Management करिा आदद ।   Microsoft Company के Founder बबल गेटस (Bill Gates) हैं जो दनुिया 

के सबसे अमीर व् यजितय  क  सूीी में आते हैं।  

Microsoft Office से जुड़ी कुछ और बातें:- 

  

 

 

 

 

 

 

 

 

 

 

 

Microsoft Office Versions Release Date 



 

MS Office की विशेषताएं (Features of MS Office) 

1. MS Office क  सबसे बडी ववशषेता यह है फक यह काि  यूजर फ्रें डली है। 

2. इसमें दी गई अलग अलग एजललकेशि और पैकेज के जररए आप अलग अलग तरह के कायों को कर 
सकते हैं। 

3. इसके सभी Program एक दसूरे से ममलते जुलते हैं इसमलए इि पर काम करिा आसाि हो जाता है। 

4. इसके सरल इंटरिेस क  वजह से इसके टूल्स का उपयोग करिा आसाि हो जाता है। 

5. MS ऑफिस को समय-समय पर अपडटे फकया जाता है। 

6. इसक  मदद से ऑफिस के सभी डडजजटल कायो को आसािी से मैिेज फकया जा सकता है। 

Component of Microsoft Office in Hindi 

 Microsoft Word 

 Microsoft Excel 

 Microsoft PowerPoint 

 Microsoft Access 

 Microsoft Outlook 

 MS Publisher 

 MS Share Point 

 MS OneNote 

 

 

 



 

1. MS Word: यह सॉफ्टवयेर सबसे ज्यादा उपयोग में मलया जाता है। इसक  मदद से लेटर, डॉियुमेंट, 

एजललकेशि, ररज्यूमे आसािी से बिा सकते हैं और एडडट भी कर सकते हैं। 

 

2. MS Excel : इसका पूरा िाम MS Excel हैं। यह एक ववडंोज पर आधाररत स्प्प्रेडशीट प्रोग्राम है जो डाटा 
को टेबुलर िॉमेट में create करता है। इस सॉफ्टवेयर को सबसे ज्यादा अकाउंटेंट और ऑफिस में इस्प्तेमाल 
फकया जाता है। 

 

3. MS Power Point : प्रेजेंटेशि बिािे के मलए इसका इस्प्तेमाल फकया जाता है। इसमें मल्टीमीडडया जैसे 
फक िोटोज, साउंड, एनिमेशि, ग्राफििस का सपोटय ददया जाता है। फकसी भी डाटा और सूीिा को 
ववजुलाइजेशि के मलए पावर लवाइंट का उपयोग फकया जाता है। 

 

4. MS Access : यह एक डाटाबेस मैिेजमेंट सॉफ्टवेयर है अलग अलग ररपोटय, िॉमय और टेबल तैयार करि े
के मलए इसका इस्प्तेमाल फकया जाता है। 

 

5. MS Outlook :  इसे E-Mail Client के िाम से भी जािा जाता है। इसका उपयोग ई-मेल भेजिे के 
मलए, मैिेज करिे के मलए और ररसीव करिे के मलए फकया जाता है। 

 

6. MS Publisher : ग्राफििस डडजाइि और ऑिलाइि कंटेंट पजललश करिे वालो के मलए यह एक अच्छा 
ववकल्प है। इसमें मौजूद टेम्पलेट िामक सॉफ्टवेयर क  मदद से कैलेंडर, बैिर बबजिेस काडय, सदटयफिकेट 
या डडजजटल एड्स तैयार कर सकते हैं। 

 

7. MS Share Point : इसमें डाटा को स्प्टोर फकया जा सकता है। इसमें वेबसाइट Collaboration मसस्प्टम 
होता है जजसक  मदद से टीम मेंबर के साथ िाइल और डाटा को आसािी से शयेर कर सकते हैं। 

 

8. MS OneNote : यह डडजजटल िोटबुक एजललकेशि है। यह स्प्टूडेंट के मलए काि  ज्यादा उपयोगी है। यह 
One Drive से मलकं होता है इसक  वजह से िोट को मसिय  कंलयूटर से हीं िहीं मोबाइल से भी एिसेस 
फकया जा सकता है। 

 

Microsoft Office Suite के अदंर हमें कई Software ममलते हैं उिमें से हम MS Word, MS Excel, 

MS PowerPoint सीखेंगे। 

 

                        

 



 

 

 

Microsoft Word इसका Short Name MS-Word होता है यह एक 

Word Processing Software होता है जजसक  मदद से हम कोई भी 

Document बिा सकते हैं उसमें बदलाव कर सकते हैं उसमें वे सारे 

Tools होते हैं जो फकसी भी Document को बिािे के मलए जरूरी होते हैं 

इससे आप Letter, Resume, Application, Invitation आदद आसािी 

से Type कर सकते है Microsoft Word दनुियाभर के कायायलय  में 

सबसे ज् यादा प्रयोग क  जािे वाली Application Software है इसमें 

work करिे के मलए एक Document पेज होता है। 

MS-Word में बनन ेिाली फाइल का Extension Name  

 .doc (2003 Versions)  

 .docx (2007, 2010, 2013, 2016, 2019, 2021 Versions) 

MS Word की विशेषताएं (Features of MS Word) 

1. MS-Word में Document एडडट करिे के मलए फॉन्ट कलर, फॉन्ट स्प्टाइल, अलाइिमेंट, बुलेट इत्यादद 
ववकल्प ममलते हैं। 

2. Document को आकषयक बिािे के मलए टेबल, ग्राि, ीाटय, ईमेज, शलेस के ववकल्प भी ममलते हैं। 

3. डडजाइि ि ीर के जररए फकसी भी टेम्पलेट क  मदद से डडजाइि तैयार कर सकते हैं। 

4. इसके अलावा पेज ले-आउट, रेिरेंस, ररव्यू जैसे ि ीसय भी ममलते हैं। 

इस एप्लीकेशन का इस्तमेाल करके ककए जाने िाले कार्य – 
1. Business Letters & Agendas 
2. Bio-Data & CV 
3. Magazines & E-Books 
4. Invitation Cards 
5. Business Reports 
6. PDF Files 
7. Labels & Stickers 
8. Application Forms 
9. Brochure & Invoices 
10. Question Papers, etc. 

Open MS Word 

माइक्रोसॉफ्ट वडय को कंलयूटर पर खोलिे के निम्ि तरीके हैं- 

Microsoft Word (MS Word) 



 

Method 1:- Click on Start Button > Select Microsoft Office > Microsoft Word 

 

Method 2:- Write WinWord in Run Dialog Box (Press Window + R Key Then Run 

Dialog Box Will be Open & Click on ok Button. 

 

Method 2:- Right Click on Desktop> New> Microsoft Office Word Document 



 

  

उपरोक्त मे से ककस़ी भ़ी Method का उपर्ोग करके Microsoft Word स्टाटय कर सकते हैं। 

नोट – अगर र्ह सॉफ्टिेर्र आपके Computer पर इंस्टॉल नहीं है, तो उपरोक्त Method कार्य 
नहीं करेंगे। 

 

MS Word ओपन होन ेके बाद Blank Document पर क्क्लक करना है। 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Title Bar- Title Bar Window में सबसे ऊपर क्षैनतज पट्टी होती है इसमे File Name, Search Bar, 

Account Sign in और Title Bar के Right Side मे तीि Control Button होते है। जजिके िाम 

Minimize, Maximize और Close होता है। Default प्रोग्राम का शीषयक Document-1 होता है। 

Menu Bar- यह टाइटल बार के ठीक िीीे होता है इस पर File, Home, Insert, Design, Page 

Layout, Reference, Mailing, Review, View िाम के मेन्यू होते हैं जजि पर जिलक करके डाियूमेंट 

क्र ऐट व मैिेज करिे के कई तरह के ऑलशि ममलते है।  

Ribbon – टैब के िीी ेका क्षेत्र जो एक पट्टी के रूप मे प्रदमशयत होता है। इसमें ीयनित टैब से संबंधधत 

टूल्स प्रदमशयत होते है। यह सभी Tools कायय के अिुसार ग्रुप मे व्यवजस्प्थत होते हैं। Ctrl + F1 दबाकर 

Ribbon को hide/unhide फकया जा सकता है। 

Quick Access Toolbar – यह टूलबार Ribbon के ऊपर प्रदमशयत होती है। इस टूलबार मे ऐसे ववकल्प 

उपललध होते है जजिका इस्प्तेमाल बार-बार फकया जाता है; जैसे – Save, Undo, Redo आदद। इस टूलबार 

के ववकल्प  को user के अिुसार कास्प्टमाइज़ भी फकया जा सकता है। 

Tabs 

Ribbon 

Quick Access Toolbar 

Ruler 

Title Bar 

Scroll Bar 

Zoom In/Out 

Layout Buttons Status Bar 

Document Page 



 

Ruler – यह एक स्प्केल क  तरह ददखता है, जो Document Page के ठीक ऊपर व बाएं प्रदमशयत होता 

है। यह पेज क  Margin Set करिे में मदद करता है। 

Page Area (document Page) – यह मुख्य एररया होता है, जहां हम डॉियूमेंट क  जािकाररय  को 

मलखते हैं। 

Scroll Bars – स्प्क्रॉलबार पेज के फकिार  पर प्रदमशयत होती हैं। इिका उपयोग पेज को ऊपर-िीीे, दायें-बाएं 

स्प्क्रॉल करिे के मलए फकया जाता है। 

Status Bar – यह बार वतयमाि Document क  जरूरी जािकाररय  को ददखाती है, जैसे – कुल पेज, कुल 

शलद आदद। 

Layout Buttons – यह टूलबार पेज को ववमभन्ि लेआउट मे बदलता है जैसे- Normal Layout, Print 

Layout, Web Layout, Reading Layout आदद। यह टूलबार Status Bar के Right Side होता हैं। 

Zoom Buttons – यह बार Layout Buttons के साथ ही प्रदमशयत होती है। इसके द्वारा पेज को Zoom 

in या Zoom out कर सकते हैं। 

MS Word File Menu 
File Menu पहला Menu होता है। इस मेनू के विभभन्न विकल्प ि उनके उपर्ोग ननम्नभलखित हैं 

Info: - इस कमांड क  सहायता स ेआप MS Word में Open फकये गए िाइल या आपके द्वारा बि े
गए िाइल का प्रॉपट ज यानि जािकारी बताता है। 

1. सबसे पहले कोई िाइल open कर ले या खदु से कोई िया प्रोिाइल बिा ले। 
2. अब File menu में जाये या इसका Shortcut keys ALT+F को प्रेस करे। 
3. अब info पर जिलक करे। 



 

4. इतिा करते ही आपके िाइल का ये प्रॉपट ज Right Side बता देगा। 

प्रॉपटीज में info आपको ननम्न च़ीजो की जानकारी देता है 
 Size 

 Pages 

 Words 

 Total Editing Time 

 Title 

 Tag 

 Comments 

 Created Date etc. 

 

 

 

MS Word के फाइल मेन ूके info कमांड की विशषे बातें 
 आप जैसे ही info कमांड पर जिलक करते हैं यहााँ आपको Protect Document का ऑलशि ममलता 

है। 
 आप MS Word में कोई भी िाइल में पासवडय या sign या Restriction इसी कमांड के द्वारा लगा 

सकते हैं। 



 

 इसमें आपको पांी कमांड ममलते हैं। 
1. Mark As Final 

2. Encrypt With Password 

3. Restrict Editing 

4. Always Open-Read-Only 

5. Add A Digital Signature 

 

1. Mark as Final: - इस कमांड क  सहायता से आप अपिे िाइल को final बता सकते हैं इसके प्रयोग 
से आप फकसी को ये बता सकते हैं क  आपका ये िाइल पूरा कम्पलीट हैं। यानि क  देखिे वाला समझ 

जायेगा क  यह िाइल कम्पलीट है और कुछ भी इसमें एडडट िहीं करिा है। 

2. Encrypt With Password: - इस कमांड क  सहायता से आप अपि ेिाइल में पासवडय लगा सकत े

हैं इससे यह होगा क  जब भी आपका यह िाइल कोई Open करेगा तो उससे पासवडय मांगेगा जजससे 

क  कोई दसुरा आपका िाइल Open िहीं कर पायेगा और आपका िाइल सुरक्षक्षत रहेगा। 

3. Restrict editing:- इस कमांड क  सहयता से आप अपिे िाइल को Restrict मोड में डाल सकते हैं 

यानि क  आपका िाइल को कोई एडडदटगं िहीं कर सकता है  इससे आपका िाइल सुरक्षक्षत रहता है। 

4. Always Open Read Only:- इस कमांड से आप अपिे िाइल को Read Only Mode में कर 
सकते हैं इससे यह होगा क  जब भी आपका ये िाइल कोई Open करेगा तो उसे एडडट या कुछ भी 

छेडखािी का ऑलशि िहीं ममलेगा  जजससे आपका िाइल सुरक्षक्षत रहेगा  और रीडर मसिय  इस िाइल को 

पढ़ पायेगा। 



 

5. Add A Digital Signature:- इस कमांड क  सहायता से आप अपिे िाइल में Signature को add 

कर सकते हैं यानि क  आप अपिे डाियूमेंट्स में अपिा डडजजटल sign लगा सकते हैं  इससे आपके 

िाइल में डायरेिट sign जोड सकते हैं। 

New: - इस ववकल्प के द्वारा आप िई वडय िाईल बिा सकते है। आप जैसे ही इस ववकल्प पर जिलक 
करेंगे आपको एक िई ववडंो ददखाई देगी। जजसमें आपको िई वडय िाईल बिािे के मलए कई प्रकार के ववकल्प 
ममलेंगे जैसे – Blank Document, Templates 

 Blank Document: - इस ववकल्प पर जिलक करके आप एक खाली वडय िाईल बिा सकते है। 

 Templates: - इस ववकल्प के द्वारा आप कई प्रकार के पहले से बि ेहुए टेम्ललेट वाली वडय िाईल 

बिा सकते है जैसे – Letter, Cards etc. यह ववकल् प आपको Pte-Designed टेम् ल लेट उपलल ध 

कराता है। 

 
 
Open: - इस कमांड फक सहायता से आप MS Word में पहले से सेव फकये हुए डाियूमेंट्स को open 

कर सकते हैं। 
1. सबसे पहले File menu में जाये या इसका Shortcut Keys ALT + F  को प्रेस करे। 
2. अब open पर जिलक करे या इसका Shortcut Keys Ctrl + O को प्रेस करे। 
3. अब open का एक छोटा सा ववडंो खलु जायेगा। 
4. उसमे अपिा save फकया हुआ डाियूमेंट्स ीिुे। 
5. अब open पर जिलक करे। 
6. इतिा करते ही वो िाइल MS Word में open हो जायेगा। 



 

Save: - जो डॉियूमेंट आपिे Type फकया है उसे Save करिे के मलए Save कमांड का उपयोग फकया 

जाता है Save कमांड क  सहायता से उस िाइल का िाम और उस िाइल को फकस Location पर रखिा है 

इसमलए Save कमांड का उपयोग फकया जाता है। 

File को save करिे के मलए File Menu में जाकर Save Button पर जिलक करें या फिर Ctrl + S 

का उपयोग करें। 

Note: - याद रखे क  आपिे अगर पहले स ेसवे फकये गए िाइल को open कर एडडदटगं फकया है और 
आपिे सेव कमांड्स का उपयोग फकया तो वह उसी िाइल और िाम से वही सेव हो जायेगा यानि क  आपका 
वो िाइल update हो जायेगा । अगर आपिे सेव फकये गए िाइल को open ि करके new drawing 

बिायीं है और आपिे सेव कमांड्स का उपयोग फकया तो आपसे सेव किे के मलए जगह, िाम मांगेगा । 

Save As: - Save क  गयी file में कुछ पररवतयि करके उसे फकसी और िाम, Format तथा Location 

पर Save करिे के मलए इसका उपयोग फकया जाता है। Save As करिे के मलए Ctrl+Shift+S शॉटयकट 
का प्रयोग करते हैं। 

Print: - इस कमांड क  सहायता से आप MS Word में Open फकये गए डाियूमेंट्स या बिाये गए 

डाियूमेंट्स को print कर सकते हैं। 

1. सबसे पहले कोई डाियूमेंट्स open कर ले या कोई डाियूमेंट्स बिा ले। 
2. अब File menu में जाये या इसका  Shortcut keys ALT+F को प्रेस करे। 
3. अब Print पर जिलक करे। 
4. अब वहां दाई ओर बगल में ददए गए Settings को अपिे अिुसार सेट करे और फिर सबसे ऊपर 

Print के ददए गए icon पर जिलक करे । 
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ध्र्ान दे वप्रटं करने के भलरे् आपका Computer/Laptop Printer से कनेक्ट होना चाहहए 
MS Word के फाइल मेनू के print कमांड की विशषे बातें 

इस कमांड में आपको Page Setup का ऑलशि ममलता है । 

इसमें आपको तीि ऑलशि ममलते हैं । 

1. Margins 
2. Paper 
3. Layout 

Print निकलिे से पहले अपिे डाियूमेंट्स के पेज का एक बार page setup जरुर कर ले इससे आपको 
पहले ही पता ील जाता है क  आपका पेज कैसा ददख रहा है । 

1. Margins:- इसमें आपको margins, orientation और pages ीिुिे का ऑलशि ममलता है, जजसे 

आप अपिे मजी अिुसार सेलेिट कर सकते हैं 

2. Paper:- इसमें आपको paper size , paper source और print option ीिुिे का ऑलशि ममलता 
है, जजसे आप अपिे मजी अिुसार सेलेिट कर सकते हैं 

3. Layout:- इसमें आपको section और header & footer ीिुिे का ऑलशि ममलता है, जजसे आप 
अपिे मजी अिुसार सेलेिट कर सकते हैं 

 



 

Share: - इस ऑलशि के द्वारा मौजूदा डाियूमेंट को Microsoft One Drive पर अपलोड कर अन्य 

लोग  को शयेर कर सकते हैं। 

Export: - इस ऑलशि के द्वारा मौजूदा डाियूमेंट को PDF िाइल में एिस्प्पोटय कर सकते हैं। 

Close: - इसके द्वारा आप MS Word को Close यानि क  बंद कर सकते हैं। 

Account: - यह ऑलशि Microsoft Word के लाईसेंस को ऐजिटवेट करिे के मलए तथा अपडटे 

सेदटगं्स को मैिेज करिे के मलए उपयोग फकया जाता है। 

Options: - Microsoft Word क  सम्पूर्य सेदटगं्स को मैिेज करिे के मलए इस ऑलशि का उपयोग 

फकया जाता है। 

MS Word home menu  

MS Word का Home Menu 5 भागो में बटा हुआ होता है। 

1. Clipboard 
2. Font 
3. Paragraph 
4. Styles 
5. Editing 

 

1. CLIPBOARD: - Clipboard में आपको Cut, Copy और Paste, Paste Special करिे का 
ऑलशि ममलता है। इस Clipboard क  सहायता से आप फकसी Word, िोटो को Cut, Copy और 
Paste कर सकते हैं। 

 

 Cut: - डाियूमेंट में मलखे टेिस्प्ट को एक स्प्थाि से दसूरे स्प्थाि पर मूव करिे के मलए Cut ऑलशि का 
उपयोग करते हैं। टेिस्प्ट को कट करिे के मलए टेिस्प्ट को मसलेिट करेंगे फिर Cut ऑलशि पर जिलक 
करेंगे। इसक  शॉटयकट क  Ctrl + X होती हैं। 



 

 Copy- Selected Text क  Duplicate Copy बिािे के मलए Copy Option का उपयोग फकया 

जाता है। इसक  शॉटयकट क  Ctrl + C होती हैं। 

 Paste- Cut या Copy फकये गए Text को Cursor के स्प्थाि Paste करिे के मलए इस ऑलशि 
का उपयोग करते हैं। 

 Paste Special:- Cut या Copy फकए गए टेिस्प्ट को अनतररित ि ीर के साथ पेस्प्ट करिे के मलए 
इस ऑलशि का उपयोग करते हैं, जैसे – मलकं बिािा, वपिीर के रूप में पेस्प्ट करिा आदद। 

 Format Painter:- टेिस्प्ट क  िॉमैदटगं कॉपी करिे के मलए इस ऑलशि का उपयोग करते हैं, जजस 
टेिस्प्ट क  िॉमैदटगं कॉपी करिी है उस टेिस्प्ट पर कसयर रखें फिर Format Painter ऑलशि पर जिलक 
करें, इसके बाद उस टेिस्प्ट को मसलेिट करें जजस पर िॉमैदटगं अललाई करिी हैं। 
 

2. FONT: - Font सेिशि में आपको font का साइज़ बढ़िे घटिे या उसका रंग change करिे या 
उसका background check करिे और भी बहुत कुछ कम इसके द्वारा फकये जा सकत ेहैं इस font 

क  सहायता स ेआप फकसी word सेलेिट फकये हुए भाग को रंगीि या और भी बहुत ज्यादा इिेिट्स 
इस पर कर सकते हैं।  

 

 Font Style: - Font Style के द्वारा आप word में मलखे गए फकसी भी words का style change 

कर सकते हैं, इसमें आपको बहुत सारे Text Style ममल जायेंगे जजसके द्वारा आप अपि ेText के 

Style को Attractive बिा सकते हैं 

 Font Size: - टेिस्प्ट का साइज़ कम या ज्यादा करिे के मलए Font Size ऑलशि का इस्प्तेमाल करत े
हैं। 

 Change Case :- टेिस्प्ट को कैवपटल केस, स्प्मॉल केस, सेंटेन्स केस आदद में बदलिे के मलए Change 

Case ऑलशि का इस्प्तेमाल करते हैं और भी इसमें Tools उपललध है, जजन्हें आप प्रयोग कर सकत े

हैं।  

1. Sentence Case 
2. Uppercase 
3. Lowercase 
4. Capitalize Each Word 
5. tOGGLE cASE 

 Clear All Formatting: - इसके द्वारा आप word में जजस फकसी words पर जो भी इिेिट्स 
डाले थे उि सभी इिेिट्स को एक साथ ये हटा देगा। 

 Bold {Ctrl + B}:- Selected Text को मोटा करिे के मलए इसका उपयोग फकया जाता है। 



 

 Italic {Ctrl + I}:- Selected Text को नतरछा करिे के मलए इसका उपयोग फकया जाता है। 
 Underline {Ctrl + U}:- Select फकये गए Text के िीी ेएक लाइि खीीिे के मलए। 
 Strikethrough:- इसके के द्वारा आप फकसी Words को बीी में से काट सकते हैं, जैसे आपलोग 

अपिे Copy में मलखते समय कुछ गलत Words को बीी से काट देते है same वही काम यह करता 
है।  

 Superscript {Ctrl + Shift + +}:- Select फकये गए Text को बेसलाइि के ऊपर (घात के रूप में) 

करिे के मलए इसका उपयोग फकया जाता है। जसेै- (A+B) 2 = A2+b2+2ab 

 Subscript {Ctrl + + =}:- सेलेिट फकये गए टेिस्प्ट को बेसलाइि के िीी े करिे के मलए इसका 
उपयोग फकया जाता है। C2H12O6 = Glucose 

 Text Effects:- इसके के द्वारा आप अपिे Words को सेलेिट कर इस पर बहुत ही अच्छे इिेिट्स 
डाल सकते है, इस पर जिलक करेन्गे तो आपको बहुत सारे Design आपको ददखेंगे जो भी आपका मि 
हो उस पर जिलक करे। 
इसमें आपको ननच ेकी ओर बहुत सारे और ऑप्शन भमल जाते हैं क्जसके द्िारा आप अपने words पर 
और बहुत ज्र्ादा इफेक््स डाल सकते हैं 
 
1. Outline 

2. Shadow 

3. Reflection 

4. Glow 

5. Number styles 

6. Ligatures 

7. Stylistics sets 

 Text Highlight Color: - सलेिटेड हुए टेिस्प्ट को हाइलाइट करिे के मलए इस ऑलशि का इस्प्तेमाल 
करते हैं। 

 Font Color:- रंगीि टेिस्प्ट मलखिे के मलए Font Color ऑलशि का इस्प्तेमाल करते हैं। 

3.  Paragraph: - टेिस्प्ट, लाइि या फकसी पैराग्राि को अलाइि (Align) करिे और आप अपिे 
Words के पहले numbering या bullets लगा के इसे अधधक attractive बिा सकते हैं और 
Paragraph सेिशि के अतंगयत निम्ि ववकल्प मौजूद होते हैं। 

 



 

 Left: - टेिस्प्ट को पेज में बाईं तरि से मलखिे के मलए Left ऑलशि का इस्प्तेमाल करते हैं – 
 Center: - टेिस्प्ट को पेज के बीी में मलखिे के मलए Center ऑलशि का इस्प्तेमाल करते हैं। 
 Right: -  टेिस्प्ट को पेज में दादहिी तरि से मलखिे के मलए Right ऑलशि का इस्प्तेमाल करते हैं। 
 Justify: - इस ऑलशि के द्वारा डाियूमेंट में मलखा गया टेिस्प्ट दाईं व बाईं माजजयि से बराबर सेट हो 

जाता है। 
 Line And Paragraph Spacing:- मलखे गए टेिस्प्ट में लाइि  के बीी गैप या स्प्पेस को अजस्प्ट 

करिे के मलए इस ऑलशि का उपयोग करते हैं। 
 Border: - उस Paragraph को Select करें जजसके ऊपर आप एक Border को लगािा ीाहते हैं। 

 Bullets – फकसी जािकारी क  अि-ऑडयर मलस्प्ट बिािे के मलए Bullets ऑलशि का इस्प्तेमाल करते हैं। 
जैसे – 

 MS Word 

 MS Excel 

 MS PowerPoint 

 Numbering – फकसी जािकारी क  ऑडयर मलस्प्ट बिािे के मलए Numbering ऑलशि का इस्प्तेमाल 
करते हैं। जैसे – 

1. MS Word 

2. MS Excel 

3. MS PowerPoint 

 Increase/Decrease Indent: – फकसी पैराग्राि को दाएं या बाएं खखसकािे के मलए इि ऑलशि 
का इस्प्तेमाल करते हैं। इसके मलए पैराग्राि पर कसयर रखें और ऑलशि पर जिलक करें। 

 Sort: - इस Option क  मदद से हम अपिे डेटा को Sort कर सकते हैं इसमें हम एक साथ अलग-

अलग कलम को Sort कर सकते हैं। 

4. Styles: - स्प्टाइल के द्वारा टेिस्प्ट को ववमभन्ि प्रारूप  (Styles) में बदल-बदल कर मलखा जा सकता 
हैं। यहााँ कुछ रेडीमेड स्प्टाइल्स भी उपललध होती हैं इिके अलावा पसंदीदा स्प्टाइल्स क्र ऐट भी कर सकते हैं। 
 

 



 

5. Editing: - इस कमांड में आपको तीि ऑलशि ममलते हैं जो क  बहुत useful है, तो ीमलए 

जािते हैं उिके बारे में एक एक करके- 

 

 Find: – डाियूमेंट में फकसी शलद या जािकारी को खोजिे के मलए Find ऑलशि का इस्प्तेमाल करते 

हैं। इसक  शॉटयकट क  Ctrl + F होती है। 

 Replace: – डाियूमेंट में मलखे टेिस्प्ट में फकसी शलद या जािकारी को फकसी अन्य जािकारी से 
बदलिे के मलए Replace ऑलशि का इस्प्तेमाल करते हैं। इसक  शॉटयकट क  Ctrl + H होती है। 

 Select: – डाियूमेंट के टेिस्प्ट, शलेस या फकसी अन्य ऑलजेिट को सलेिट करिे के मलए इस ववकल्प 

का उपयोग फकया जाता है। 

MS Word Insert Menu 
इन्सटय टैब के अतंगयत डाियूमेंट मे पेज, टेबल, मीडडया, शलेस, मलकं, मसबंल्स आदद को जोडिे के मलए 

अिेक  ववकल्प आते हैं। इि सभी ववकल्प  को ववमभन्ि ग्रुलस मे बांटा गया है जो निम्ि प्रकार हैं- 

 

1. Pages 

2. Tables 

3. Illustrations 

4. Add-ins 

5. Media 

6. Links 

7. Comments 

8. Header & Footer 

9. Text 

10. Symbols 



 

1. Pages: - इसमें आपको Cover Page, Blank Page एवं Page Break तीि ऑलशि ममलते हैं 

। इस ऑलशि क  सहायता से आप word में पेज को एडडट करिे का काम कर सकते हैं। 

 

 Cover Page: - डाियमूेंट के मलए कवर पेज बिािे के मलए Cover Page ऑलशि का इस्प्तेमाल करत े

हैं। इसमे कई सारे रेडीमडे कवर पेजेस का संग्रह होता है। कवर पेज डाियूमेंट का फ्रन्ट पेज होता है, 

जजसमे डाियूमेंट से संबंधधत जािकाररयााँ मलखी जाती हैं। 

 Blank Page:- इस पर जिलक कर आप Word के पेज पर एक और Blank पेज ला सकते हैं, जैस े

ही आप इस पर जिलक करेंगे तो जहााँ आपका Cursor होगा वहां से Cutting जैसा Line आ जायेगा 

और इस तरह ऊपर िीी ेदो पेज बि गया। 

 Page Break: - इस पर जिलक कर आप Word में एक ही पेज पर पजे ब्रेक कर सकते हैं यािी क  

एक पेज को आप जजतिा बार ीाहे तोड सकते हैं। 

2. Tables: - इसमें आपको मसिय  एक ही Table का ऑलशि ममलता है लेफकि इसके अन्दर आपको 

पांी ऑलशि ममलते हैं। 

 



 

 

 Insert Table - इस ऑलशि के द्वारा डाियूमेंट में रो और कॉलम से बिी टेबल जोड सकते हैं, जजसस े
फकसी प्रकार क  जािकारी को रो और कॉलम में मलखा जा सकता है। 

 Draw Table - इस ऑलशि के द्वारा पेंमसल का उपयोग करते हुए टेबल ड्रॉ कर सकते हैं, पेंमसल के 

उपयोग से मिीाही टेबल बिा सकते हैं। 

 Excel spreadsheet - इसक  सहायता से आप Word में Excel के Sheet को ला सकते हैं | 

 Quick Tables - इसक  सहायता से आप word में बहुत ही बदढ़या तरीका का Calendar और टेबल 

Insert सकते हैं। 

3. Illustrations: - इस सेिशि के अतंगयत डाियूमेंट मे ववमभन्ि प्रकार के ऑलजेिट्स को जोडा जा 

सकता है। डाटा को ग्राफिकल िॉमय मे प्रस्प्तुत करािे के मलए Illustrations सेिशि के अतंगयत निम्ि 

ऑलशि उपयोग फकए जा सकते हैं। 

 

 

 Pictures: – Document में offline माध्यम से Pictures जोडिे के मलए इस ऑलशि का उपयोग 
करते हैं। 

 Online Pictures: – Document में Online माध्यम से Pictures जोडिे के मलए इस ऑलशि 

का उपयोग करते हैं। 

 Shapes: – डाियूमेंट में ववमभन्ि प्रकार क  आकृनतयााँ जैसे – Circle, Box, Triangle, Line, Arrow, 

Flow Chart आदद जोडिे के मलए Shapes ऑलशि का उपयोग करते हैं। 

 Smart Art: – स्प्माटय आटय एक ग्राफिकल ऑलजेिट होता है, इिका इस्प्तेमाल करके फकसी जािकारी 

जैसे टेिस्प्ट, वपिीर आदद को एक साथ List, Process, Cycle, Hierarchy, Pyramid आदद प्रारूप  

में प्रदमशयत करा सकते हैं।  

 Charts :– ीाटय भी एक Graphical Object होता है, Chartका इस्प्तेमाल करके rows और 

columns में मलखी जािकारी को ग्राफिकली प्रदमशयत करा सकते हैं। जैसे फकसी शीट में दजय फकसी कंपिी 

क  वावषयक सेल्स ररपोटय को ीाटय क  मदद से प्रस्प्तुत कर सकते हैं। 



 

 Screenshot:- इसक  सहायता से आप word में अपिे लैपटॉप के कोई भी स्प्क्र ि या प्रोग्राम के 

स्प्क्र िशॉट को तुरंत लगा सकते हैं 

Note: - ऑलजेिट कोई वपिीर, आइकाि, शपे, ीाट्यस आदद हो सकते हैं, जब फकसी ऑलजेिट को 

मसलेिट फकया जाता है तो सेलेिटेड ऑलजेिट को कंट्रोल करिे के मलए Format िाम से एक अन्य टैब 

(Tab) स्प्वयं से ओपि (Open) हो जाता है, जजसमे अलग-अलग ऑलजेिट्स के अिुसार ववकल्प ददए होत े

हैं तथा कुछ ववकल्प सभी के मलए कॉमि होते हैं। ये सभी ववकल्प निम्िमलखखत हैं – 

 

Options in Format Tab 

 Styles: – इसके द्वारा ऑलजेिट क  स्प्टाइल को बदल सकते हैं तथा फकसी object जैसे shape, 

picture आदद को ववमभन्ि प्रारूप  मे बदल सकते हैं। 

 Fill Color: – अगर कोई object shape है तो उसमे Color Fill सकते हैं। 

 Outlines: – इस ऑलशि के द्वारा शपे या object क  आउट्लाइि कलर और मोटाई मैिेज कर 

सकते हैं। 

 Effects: – object पर ववमभन्ि प्रकार से इिेिट लागू कर सकते हैं, जैसे – Drop Shadow, 

Reflection, Glow आदद। 



 

 Positions: – object को पेज में फकस पोजीशि पर सेट करिा है, यह सेट कर सकते हैं जैसे – 

Top, Bottom, Center, Right, Left, and Middle. 

 Text Wrap:– डाियमूेंट में मलखे टेिस्प्ट को ऑलजेिट के साथ फिट करिे के मलए Text Wrap 

ऑलशि का इस्प्तेमाल करते हैं, फकसी object को In Line, Tight, Square, Behind Text, In 

front of Text आदद रूप में सेट कर सकते हैं। 

 Arrange :– डाियूमेंट में अगर एक से अधधक object जोड ेगए हैं, तथा उिमे से फकसी object 

को फकसी object के ऊपर या िीी ेकरिा है तो Arrange सेिशि के अतंगयत Send to Back/Bring 

to Front ऑलशि के द्वारा कर सकते हैं। 

 Align; – मल्टीपल object को एक साथ वदटयकली या होररजॉन्टली अलाइि करिे के मलए इस ऑलशि 

कर इस्प्तेमाल करते हैं। 

 Group: – एक से अधधक object को एक साथ ग्रुप करके एक ऑलजेिट बिािे के मलए Group 

ऑलशि का इस्प्तेमाल करते हैं, ग्रुप फकए गए object को पुिः अलग करिे के मलए Ungroup ऑलशि 

का इस्प्तेमाल करते हैं। 

 Rotate: – फकसी वपिीर, शपे या object को 90, 180, 360 डडग्री तक घुमािे के मलए Rotate 

ऑलशि का इस्प्तेमाल करते हैं। 

 Size: – इसके द्वारा Object क  Height व Width Adjusted कर सकते हैं। 

4. Media: - इसमें आपको मसिय  एक Online Videos का ऑलशि ममलता है जजसके माध्यम से 

आप Word में कोई भी ऑिलाइि ववडडयो को जोड सकते हैं। 

 

 Online Videos - इस पर जिलक करते ही आपसे यूआरएल मांगेगा , आप कोई भी YouTube या 
अन्य कही का ववडडयो का यूआरएल देकर ok करें। ok करते ही उस मलकं से संबंधधत ववडडयो आपके 

Word में जुड जाएगा। 

5. Links: - डाियूमेंट मे फकसी टेिस्प्ट पर मलकं लगािे के मलए निम्ि ऑलशन्स का उपयोग फकया जा 

सकता है। 



 

 

 Hyperlinks:– Document में मलखे फकसी टेिस्प्ट या जािकारी पर फकसी बाहरी पेज, URL, File, 

Folder आदद का मलकं लगा सकते हैं। ऐसा करिे के मलए Text Select करेंगे फिर Hyperlink 

ऑलशि पर जिलक करके जजस जािकारी का Link बिािा है वह Option ीिुेंगे। Hyperlink क  

शॉटयकट कंुजी Ctrl + K होती हैं। 

 Bookmarks:– यदद Document मे एक से अधधक Pages हैं तो Document क  मुख्य 

जािकाररय  के Bookmarks क्र ऐट कर सकते हैं, ताफक उस इििामेशि पर बबिा स्प्क्रॉल फकए डायरेिट 

पहंुीा जा सके। Document में जजस जािकारी का Bookmark क्र ऐट करिा है उस जािकारी को 

मसलेिट करे इसके बाद Bookmark ऑलशि पर जिलक करें और बबिा स्प्पेस ददए फकसी िाम से सेव 

करें। बिाए गए Bookmarks को एिसेस करिे के मलए Bookmark ऑलशि का प्रयोग करेंगे।  

 Cross Reference:– Cross Reference के द्वारा Document क  जािकाररय  के मलए Cross 

Reference  बिा सकते हैं, इससे एक Label के द्वारा Document क  उि जािकाररय  तक 

आसािी से पहंुीा जा सकता है जजस जािकारी के मलए Cross Reference बिाया गया है। Cross 

Reference बिािे के मलए Headings उपयोग भी फकया जा सकता है। इसके मलए जहां Cross 

Reference बिािा है वहााँ कसयर रखे और फिर Insert>Cross Reference Option पर जिलक करें। 

इसके बाद Reference Type मे Heading मसलेिट करें, फिर वह Heading ीिुे जजसका Cross 

Reference बिािा है और Ok करें। इस तरह से उस हेडडगं के मलए Cross Reference Label बि 

जाएगा, अब Label पर Ctrl + Click करेंगे तो उस Heading पर पहुाँी जाएंगे। 

6. Comments: - कमेन्ट का उपयोग फकसी टेिस्प्ट या जािकारी पर कोई िोट मलखिे के मलए फकया 

जा सकता है, जजसे नछपाया या ददखाया जा सकता है। 

7. Header and Footer  

 

 Header and Footer: - Document के प्रत्येक पेज पर एक ही जैसी सूीिा या जािकारी को 

Header Option के द्वारा प्रदमशयत करा सकते है। Header में कोई Text, Page Number, 



 

Picture आदद जोड सकते हैं। Header Page के Top एररया में प्रदमशयत होता है। Footer Page के 

Bottom एररया में प्रदमशयत होता है, इसका कायय भी Header के समाि ही होता है। 

 Page Number – Document में एक से अधधक Page होिे पर इस Option के द्वारा प्रत्येक 

Page पर Page Number जोड सकते हैं। 

 

7. Text Box – Text box बॉिस एक ऑलजेिट होता है, इसे डाियूमेंट में कहीं भी ललेस फकया जा 

सकता हैं। Text box में Text को Multiple Directions में मलख सकते हैं। 

 

 Quick Parts :– Quick Part Microsoft Word का एक उपयोग ि ीर है, इसके द्वारा ऐसी 

जािकाररय  को सुरक्षक्षत फकया जा सकता है जजन्हे बार-बार उपयोग मे लाया जाता हो, जैसे – कोई िाम, 

पता आदद। जािकारी को Quick Part मे सेव करिे के मलए जािकारी को सलेिट करें और 
Insert>Text>Quick Part>Save Selection to Quick Part ऑलशि पर जिलक करें, तथा िाम, 

लोकैशि व अन्य जािकारी भरकर Ok करें। Quick Part के अदंर कई ववकल्प आते हैं जैसे – 

Document Property के अदंर फकसी डाियमूेंट से ररलेटेड कई ववकल्प उपललध होते है जैसे – 

Author, Subject, Title, Category, Company, Publish Date आदद। इि ि ल्ड्स को डॉियूमेंट 

मे इन्सटय कर जािकारी को अपडटे फकया जा सकता है। 

 Word Arts :– Word Arts decorative text objects होते हैं, इन्हे Document में कहीं भी 

ललेस फकया जा सकता है। Selected Word Art के मलए अलग से Format tab open होता है जहा ं

से इसे ववमभन्ि options के द्वारा कस्प्टमाइज़ भी फकया जा सकता है। 

 Drop Cap – इस option के द्वारा फकसी paragraph का पहला अक्षर बडा बिा सकते हैं, ताफक 

यह पता ील सके फक िया section कहा स ेStarts हो रहा है। 

 Signature Line – इस ववकल्प के द्वारा फकसी document जैसे Form, Certificate आदद मे 

हस्प्ताक्षर रेखा (Signature Line) जोड सकते हैं। signature line जोडिे के मलए माउस कसयर रखें 

फिर इस ऑलशि पर जिलक करें और िाम तथा टाइटल भरें और Ok ऑलशि पर जिलक करें। 

 Date and Time :- इसका प्रयोग कर आप word में वर्त्यमाि ददि और तारीख को ला सकते हैं। इसमें 

आपको ददि और तारीख के बहुत सारे िॉमेट ममलते हैं , आपको जो पसंद है उसका प्रयोग करें। 



 

 Object :– इस ववकल्प के द्वारा डॉियूमेंट मे अन्य फकसी एललीकेशि के ऑलजेिट जोड ेजा सकते हैं, 

तथा िाइल को बबिा बंद फकए उिपर डायरेिट कायय भी फकया जा सकता है। जैसे – MS Paint, Excel 

Spreadsheet, Photoshop Document इत्यादद। 

 Text from File :- इस पर जिलक कर अपि ेस्प्टोरेज से कोई PDF िाइल को ीिुे , अब आप देखेंगे 

क  उस PDF में जजतिा भी text और िोटो था वो सभी word में आ जायेगा। 

8. Symbols: - इसमें आपको दो ऑलशि ममलते हैं जो क  गखर्त से संबंधधत होते हैं, इिके द्वारा 

आप Word में कोई भी गखर्त का धीन्ह और सूत्र को ला सकते हैं। 

 

 Equation :- इस पर जिलक करते ही आपको गखर्त के सारे सूत्र ममल जाते हैं, आपको word में 

जजस भी सूत्र का काम है, उस पर जिलक करें वो बबलकुल आपको सूत्र के जैसा ही word में आ जायेगा 

और वैसा ही ददखेगा। 

 Symbols :- इस पर जिलक करते ही आपको गखर्त के सारे धीन्ह ममल जाते हैं, आपको जजसका 

उपयोग word में करिा है, उस पर जिलक करें । अगर आपको अधधक गखर्त के धीन्ह ीादहए तो आप 

More Symbols पर जिलक करें। 

MS Word Design Menu 

Design menu में 2 भाग है । 

1. Document Formatting 
2. Page Background 

 

1. Document Formatting: - इस भाग में कुल आपको 6 ऑलशि ममलता है। इि सभी के 

द्वारा आप पेज पर text और पेज के style को बदलिे का कायय फकया जाता है। 



 

 Themes - इसके द्वारा आप Text को अलग design और अलग रंग में ढाल सकते हैं इसमें ददए 

गए ऑलशि को जैसे ही आप सेलेिट करेंगे तो आप देखेंगे क  text का style बदलिे लगेगा। 

 Colors - इसके द्वारा आप text के रंग को बदल सकते हैं साथ ही इसके साथ रंग और आकार भी 

बदलता है। 

 Fonts - इसके द्वारा आप text के style को बदल सकते हैं। 

 Paragraph spacing - इसके द्वारा आप दो Sentence के बीी के स्प्पेस को कम या ज्यादा कर 

सकते हैं, ऑलशि में से ीिुकर जजतिा आपको बीी में स्प्पेस रखिा है। 

 Effects - इसमें उपजस्प्थत Design को आप ीिुकर अपिे font में Apply कर सकते हैं। 

 Set as Default - इस पर जिलक कर आप text में Apply सारे ीीज को हटाकर पहले जैसा 

Normal कर सकते हैं। 

2. Page Background 

 Watermarks – इस के द्वारा पेज के Background में कोई text या image को सेट कर सकते 

हैं, जो हर पेज पर समाि रूप से प्रदमशयत होता है। इसका प्रभाव डाियूमेंट में मलखे टेिस्प्ट पर िहीं पडता 

है। इसका उपयोग अिसर लोगो या कॉपीराइट आदद जािकारी प्रदमशयत करािे के मलए फकया जाता है। 

 Page Color – इस ऑलशि के द्वारा पेज के Background में मिीाहा रंग सेट कर सकते हैं। 

 Page Border – पेज पर बॉडयर लगािे के मलए Page Border ऑलशि का इस्प्तेमाल करते हैं। Page 

Border के अतंगयत अिेक  स्प्टाइमलश Page Border उपललध होते हैं जजन्हे पेज के ीार  ओर लगा 

सकते हैं। 



 

MS Word Page Layout Menu 

Layout Menu में 3 भाग है। 

1. Page Setup 
2. Paragraph 
3. Arrange 

 

 

1. Page Setup: - डाियूमेंट के लेआउट को सेटअप करिे के मलए ववमभन्ि प्रकार के ऑलशि 

Page Setup सेिशि के अतंगयत उपललध होते हैं जो निम्ि प्रकार हैं। 

 Margins – Margin Page के ीार  ओर का क्षेत्र होता है, इसे Margin ऑलशि के द्वारा सेट 
फकया जा सकता है। Page के Top, Left, Right, Bottom में जजतिा Margin सेट करेंगे, Page में 
टेिस्प्ट या जािकारी उतिा Margin छोडकर मलखी जाएगी। 

 Orientation – Orientation Option के द्वारा पेज को Portrait या Landscape Mode में 
बदल सकते हैं। Portrait Mode में पेज ऊंीाई मोड में होता है, Landscape Mode में पेज ीौडाई 
मोड में होता है 

 Size – इस ऑलशि के द्वारा Page Print करिे के मलए Printer Paper के अिुसार पेज का साइज़ 
सेट कर सकते हैं जैसे – Letter, A4, A3, Legal आदद। 

 Columns – पेज में टेिस्प्ट को एक से अधधक कॉलम में मलखिे के मलए Column ऑलशि का 
इस्प्तेमाल करते हैं। 

 Breaks - इसमें आपको बहुत सारे Options ममलते हैं जजसका प्रयोग कर हम Page को कई भाग 
में ववभाजजत कर सकते हैं। जैसे आप MS Word में कोई ऐसा एक िाइल Open कर लीजजये जो 
कम से कम 4-5 Page का हो और अब Breaks में से कोई भी Options पर जिलक करें। आप देखेंगे 
क  उस ऑलशि के दहसाब से ही आपका Page ववभाजजत हो गया | आप उि Options को पढ़कर 

यह अदंाजा लगा सकते हैं क  वो फकतिे भागो में हमारे Page को तोडगेा। 
 Line Numbers – इस ऑलशि का उपयोग करके Document क  लाइि  या Paragraphs पर 

Serial Numbers सेट कर सकते हैं। 



 

 Hyphenation :– जब फकसी line के अतं मे फकसी बड ेशलद को मलखिा हो और स्प्पेस कम हो तो 
इस ऑलशि को ऑि करिे पर लंबा शलद डशै (-) के साथ मलख ददया जाता है, अथायत शलद के जीति े
अक्षर मलख सकते हैं मलख जाएंगे बाक  new line मे ीले जाएंगे। 

2. Paragraph:- इस Section के अतंगयत paragraph क  spacing को control कर सकते 
हैं। जैसे फकसी paragraph को Top, Bottom, Right, Left फकतिा space देिा है यह set कर सकत े
हैं। 

 

 Indent: - इसमें आपको दो options ममलते हैं, जजसके द्वारा आप दो text के बीी दाये से बाये 
या बाये से दाये के बीी के स्प्पेस को कम या ज्यादा फकया जाता है। 

 Spacing: - इसमें आपको दो options ममलते हैं, जजसके द्वारा आप दो text के बीी ऊपर से 

िीी ेया िीी ेसे ऊपर के बीी के स्प्पेस को कम या ज्यादा फकया जाता है। 

3. Arrange: - इसके द्वारा आप MS Word के पेज पर Text File में कोई भी Photo या 

Shape को Edit कर सकते हैं। 

 

 Position – फकसी Shape या Picture को पेज के फकस भाग मे Automatically Set करिा है, 

इस Option के द्वारा कर सकते हैं। 

 Word Wrap – फकसी Shape या Picture को पेज मे सेट करिे पर उस पेज मे मलखा टेिस्प्ट फकस 

प्रकार से Break होगा यह सेट कर सकते हैं। 

 Bring Forward/Send Backward – फकसी Shape या Picture को फकसी अन्य Shape या 

Picture के ऊपर या िीी ेले जािे के मलए इस Option का उपयोग करते हैं। 

 Selection Pane – इस Option पर जिलक करिे से एक Pane Window खलु जाती है, जजसमे 

Document मे जोड ेगए सभी Shape क  जािकारी प्रदमशयत होती है। कई अलग-अलग Shape को 
एक साथ Selection Pane के द्वारा कंट्रोल फकया जा सकता है। 



 

 Align – कई Shape को एक साथ Vertically या Horizontally Align करिे के मलए इस Option 

का उपयोग करते हैं। इसके मलए सभी Shape  को एक साथ Select करें और ददए गए Option पर 

Click करें। 

 Group – कई Shape को एक साथ Group या Ungroup करिे के मलए इस Option का 

उपयोग करते हैं। 

 Rotate – फकसी Shape या Picture को 90, 180 या 360 डडग्री घुमािे के मलए इस Option 

का इस्प्तेमाल करते हैं। 

MS Word References Menu 

References Menu में 6 भाग है । 

1. Table of Contents 
2. Footnotes 
3. Citations & Bibliography 
4. Captions 
5. Index 
6. Table of Authorities 

 

1. Table of Contents  

 

 Table of Contents:- document मे headings के आधार पर table of contents create 

कर सकते हैं। यह document क  शुरुआत में प्रदमशयत होिे वाली एक प्रकार क  सूीी होती है जो यह 

प्रदमशयत करती है फक document में कौि सी heading फकस पेज पर है। इसे बिािे के मलए Table 

of Contents पर जिलक करें और एक format ीिुें। 



 

 Add Text - आप अपिे text में cursor रखकर अब आप add text में जिलक कर कोई भी 

ऑलशि पर जिलक करें। इतिा करिे पर आपका text का लुक बदल जाएगा। 

 Update Table - इस पर जिलक कर आप अपिे table of contents को update कर सकते हैं। 

2. Footnotes 

 

 Insert Footnote: – इस ववकल्प का उपयोग पेज के Last मे पेज से संबंधधत इििामेशि जोडिे के 
मलए करते हैं। 

 Insert Endnote: – इस ववकल्प का उपयोग डाियूमेंट के Last मे डाियूमेंट से संबंधधत इििामेशि 
जोडिे के मलए करते हैं। 

 Next Footnote: - इस पर जिलक कर आप MS Word में पेज पर जजतिे सारे Footnote और 
Endnote बिाये ह गे उस पर आप बारी-बारी जा सकते हैं | इस पर जिलक कर आप ऑलशि पर 
जिलक कर बारी-बारी से अगले Footnote और Endnote पर जा सकते हैं। 

 Show Notes: - इस पर जिलक कर आप अपिे पेज पर लाये गए सारे Footnote और Endnote 

पर डायरेिट जा सकते हैं। 
 

3.Citations & Bibliography :- अगर आप कोई Research Paper मलख रहे ह  तो उसमे 

ये देिा जरूरी हो जाता है फक आपिे फकसी खास Statement के मलए कहााँ से अध्ययि फकया है या कोई 

Formula, तथ्य या पहले के Research के पररर्ाम वगैरह जजसे आपिे आधार बिाया है उसे कहााँ से 

मलया है। अगर आप कोई लेख भी मलख रहे हैं तो आपको िीी ेCitations डालिे पडते हैं ताफक ये पता 

ीले क  आपक  मलखी ीीज  का आधार िया है और वो कहााँ से आया है। एमएस वडय में भी आप अपि े

Document में साइटेशि या Bibliography को जोड सकते हैं ताफक वो और भी प्रमाखर्क लगे। 

इसमें आपको 04 भाग भमलते हैं। 

 

 Insert Citations :– इस ववकल्प के द्वारा Citations Insert करा सकते हैं। इसके मलए इस 

ववकल्प पर click करें और Add new Source पर click करें और दी जािकारी को भरें। इसी प्रकार 



 

से एक से अधधक Citations create कर सकते हैं। अब जजस Citation को जजस टेिस्प्ट के साथ 

जोडिा है उस टेिस्प्ट को मसलेिट करे और Citation मलस्प्ट मे create फकए गए Citation पर click 

करें। इस तरह स ेटेिस्प्ट के लास्प्ट मे ब्रैफकट के अदंर (Name, Year) िाम से Citation इन्सटय हो 

जाएगा, जजसक  Details को Bibliography ऑलशि के द्वारा डाियूमेंट के आखखर (Last) मे या 

कहीं पर भी इन्सटय कर सकते हैं। 

 Manage Sources: – इस ववकल्प के अतंगयत सभी Citations क  मलस्प्ट प्रदमशयत होती हैं जजिके 

सोसय (Source) को दोबारा एडडट (Edit) फकया जा सकता है। Manage Source के अन्तगयत 

Master List व Current List प्रदमशयत होती है, Master List मे ऐसे Citations क  मलस्प्ट प्रदमशयत 

होती है जो सभी डाियूमेंट मे प्रदमशयत होती है तथा Current List के अतंगयत केवल वतयमाि डाियमूेंट के 
मलए Citations क  मलस्प्ट प्रदमशयत होती है। 

 Styles: – यहााँ Citations के मलए एक स्प्टाइल ीिु सकते हैं, जो जोड ेगए Citations को ववमभन्ि 

प्रारूप  मे प्रदमशयत करता है। 

 Bibliography: – यह ऑलशि एक से अधधक क्र ऐट फकए गए Citations क  Detailed मलस्प्ट को 

प्रदमशयत करता है, जजसे डाियूमेंट मे इस ऑलशि क  मदद से जोडा जा सकता है। 

4. Captions: - इसमें आपको 3 भाग भमलत ेहैं 

 

 Insert caption: - इस पर Click कर आप फकसी Photos के िीी ेआप text add कर सकते 

हैं। 

 Tables of figure dialogs: - इस पर Click कर आप वो सारे caption देख सकते हैं जो आपिे 
page पर जहााँ जहााँ लगाया है। 

 Update Table of figure: - इस पर Click कर आप वो सारे caption को update कर 

सकते हैं जो आपिे page पर जहााँ जहााँ लगाया है। 

 Insert cross-reference: - इस पर Click कर आप दो photos को इधर से उधर कर सकते 

हैं। 

 



 

MS Word Mailings Menu 

Mailing Tab के अतंगयत लेटर व पत्र भेजिे के मलए ववमभन्ि ववकल्प आते है। इि सभी Options को 

ववमभन्ि ग्रुलस मे बांटा गया है जो निम्ि प्रकार हैं- 

इसमें आपको 5 भाग भमलत ेहैं 

1. Create 
2. Start Mail Merge 
3. Write & Insert Fields 
4. Preview Results 
5. Finish 

 

 

1. Create 

 

Envelopes: – यह ववकल्प तब उपयोग करते हैं जब फकसी को कोई पत्र भेजिा होता है। इस ववकल्प 

के द्वारा मलफाफे पर Return Address और Delivery Address print करा सकते हैं तथा मलफाफे के 

मलए different sizes भी ीिु सकते हैं। 

Labels: – Label option के द्वारा एड्रसै के छोटे-छोटे स्प्टीकर तैयार कर सकते हैं जजन्हे मलफाफ  पर 

धीपका सकते हैं। 

2. Start Mail Merge: - इसमें आपको तीि options ममलते हैं जजससे आप प्रालतकताय और 

document भेजिे का काम edit करते हैं। 

 



 

 Start Mail Merge: - इस पर Click कर आप डॉियूमेंट का Style सेट कर सकते हैं क  आपको 

अपिा Document फकस तरह भेजिा है । जैसे Envelope , Mail या Letter जजस तरह का 

डॉियूमेंट आपको भेजिा है उसी पर जिलक करें। 

 Select Recipients: - इस पर जिलक कर आप Type a New List पर Click कर आप जजसे 

Document भेजिे वाले हैं, उसका Bio Data भरे। 

 Edit Recipient List: - यह तभी काम करेगा जब आप इसके पहले वाले Command का प्रयोग 

फकये हुए हैं। इससे आप भेजिे वाले का Bio Data को Edit कर सकते हैं। 

3. Write & Insert Fields 

इसमें आपको 5 भाग भमलत ेहैं 

1. Highlight Merge Fields 
2. Address Block 
3. Greeting Line 
4. Insert Merge Field 
5. Rules 
6. Match Fields 
7. Update Labels 

 

 Highlight Merge Fields – यह option सभी insert क  गई Fields को हाईलाइट करता है, 

इससे पत्र insert क  गई Fields को पहीाििे मे मदद ममलती है। 

 Address Block – यह ववकल्प एड्रसै ललॉक को जोडता है। लेटर मे जहां पर भी प्रालतकताय का एड्रसै 

प्रदमशयत करािा है वहााँ कसयर रखे और Address Block पर जिलक करें। 

 Greeting Line – इस ववकल्प के द्वारा प्रालतकताय के मलए एक greeting line जोड सकते हैं, जैसे 

– Dear Name, 

 Insert Merge Field – इस ववकल्प के द्वारा प्रालतकताय मलस्प्ट (Recipient List) से फकसी Field 

को insert कर सकते हैं। जैसे – Phone Number, Company Name आदद। जहां भी Field 

insert करिी है वहााँ cursor रखें और Insert Merge Field पर click करें। 



 

4. Preview Results: - इस सेिशि का उपयोग Mail Merge का Preview Result देखिे 

के मलए फकया जाता है। जजतिे भी प्रालतकताय को Email/Letter भेजा जाएगा उसका प्रारूप कैसा ददखेगा 

इस Option के द्वारा देख सकते हैं। 

5. Finish & Merge: - इस Option के द्वारा Mail Merge Complete कर सकते हैं। 

इसके द्वारा प्रत्येक प्रालतकताय को सीधे Email भेज सकते हैं, या फिर सभी प्रालतकताय क  Letter 

Copy को एक New Document में ओपि कर Print कर सकते हैं या Details को Edit भी कर 
सकते हैं। 

MS Word Review Menu 

इसमें आपको 7 भाग भमलत ेहैं 

1. Proofing 
2. Language 
3. Comments 
4. Tracking 
5. Changes 
6. Compare 
7. Protect 

 

1. Proofing 

इसमें आपको 3 भाग भमलत ेहैं 

 

 Spelling & Grammar: - document में मलखे गए टेिस्प्ट क  Spelling and Grammar 

गलनतय  को जााँीिे व ठीक करिे के मलए Spelling and Grammar option का उपयोग फकया जाता 

है। यह option स्प्वीामलत रूप से कायय करता है तथा फकसी गलती के मलए पॉमसबल suggestions 

भी प्रस्प्तुत करता है। 



 

 Thesaurus: –   इस option के द्वारा फकसी शलद के अिेक  synonyms शलद खोज सकते हैं। 

 Word Count: - इस पर जिलक कर आप word में open हुए डाियमूेंट्स में फकतिे शलद हैं, ये 

जािकारी आप प्रालत कर सकते हैं | इस पर जिलक करते ही आपको words, lines, pages इत्यादद 

का संख्या आपको ददखा देगा। 

2. Language 

 

 Translate: – इस option के द्वारा selected text या पूरे document को फकसी भी language 

मे Translate फकया जा सकता है। 

 Language: – इस option के द्वारा Translation सववयसेज़ के मलए भाषाएं सेट कर सकते हैं। 

3. Comments 

 

 Comments – इस option के द्वारा document में मलखी फकसी जािकारी पर कमेन्ट के जररए 
कोई अन्य जािकारी या Comments जोड सकते हैं, इन्हे जरूरत के अिुसार नछपाया, देखा व delete 

भी फकया जा सकता है। 
1. New Comment 
2. Delete 
3. Previous 
4. Next 
5. Show Comments 

 

4. Tracking  

 



 

 Tracking: - डाियूमेंट में बदलाव या एडडट करिे के मलए Track Changes ऑलशि को ऑि कर 
सकते हैं, तथा फकए गए बदलाव  को Reviewing Pane से देख जा सकता है। इस भाग में आपको 
ीार कमांड ममलते हैं  

1. Track Changes 
2. All Markup 
3. Show Markup 
4. Reviewing Pane 

 

5. Changes  

 
 Changes: - इसके द्वारा एक बार एडडट फकए गए डाियूमेंट को पुिः वेरीिाई फकया जा सकता है, 

जजससे फकए गए बदलाव  को Accept या Reject कर सकते हैं। 
 

6. Compare 

 

 Compare: - इससे आप एक ही डॉियूमेंट के दो अलग Version Documents के बीी Compare 

कर सकते हैं। 
 Combine: - जब आपके पास ववमभन्ि Authors का Document का संग्रह फकसी एक डॉियूमेंट 

में सेव हो, तो उस जस्प्थनत में आप उस एक Document और ववमभन्ि Documents के बीी 
Compare कर सकते हैं। 

 

7. Protect 

 
 Block Authors - ऐसे तो यह Command तभी काम करता है जब आपके पास कोई ऐसा 

Document हो, जजसमें Author सेव हो , तो इसके द्वारा उसे Block करिे का काम फकया जाता है 
। 

 Restrict Editing – इस ववकल्प के द्वारा Document को एक Password के द्वारा Protect 

फकया जा सकता है। जजससे कोई अन्य पसयि Document के साथ छेड-छाड िहीं कर सकता है। 



 

MS Word View Menu 

इसमें आपको 5 भाग भमलत ेहैं 

1. Views 
2. Show 
3. Zoom 
4. Window 
5. Macros 
 

 

 
1. View Tab: - View Tab के द्वारा Document को ववमभन्ि ववकल्प  के साथ देखा जा सकता 
है। इि सभी ववकल्प  को ववमभन्ि ग्रुलस मे बांटा गया है जो निम्ि प्रकार हैं- 

 

 Read More - इस पर जिलक करिे पर आपका MS Word का पेज पुरे Full Screen में हो जाता 
है। इसक  सहायता से हम फकसी बड ेDocument को पढिे का काम आसािी से कर सकते हैं । 

 Print Layout – यह डडफॉल्ट मोड होता है, यह मोड Document को पेज बाई पेज प्रदमशयत करता 
है तथा वप्रन्ट करािे के मलए इस्प्तेमाल फकया जाता है। 

 Web Layout – यह मोड Document को वबे पेज के रूप में प्रदमशयत करािे के मलए इस्प्तेमाल फकया 
जाता है। इस मोड मे Document के सभी पेज एक ही पेज मे बदल जाते हैं। 

 Outline View – इस मोड मे Document क  Headings, Subheadings व Text को 
Show/Hide करके देखा जा सकता है। 

 Draft - इसका उपयोग आप MS Word के पेज को ीौडा कर फकसी बड ेDocument को पढिे के 
मलए कर सकते हैं। 



 

2. Show: - MS word के पेज पर line और ruler को hide/show करिे का कायय करते हैं । 

 

 

 Ruler:– Document में Ruler को ददखािे के मलए इसे ीके करें, रूलर Ruler Margin को मैिेज 
करिे में सहायक होता है। 

 Grid Lines:– Document में Grid Line ददखािे के मलए इसे Check करें। Grid Line Objects 

को Manage करिे में सहायक होती हैं। 
 Navigation Pane:– Navigation Pane ददखािे के मलए इसे Check करें, इसक  मदद से 

Document में Headings व Pages को Navigate फकया जा सकता है। 
 

3. Zoom: - जू़म सेिशि के अतंगयत पेज को ववमभन्ि प्रकार से जू़म कर सकते हैं। जैसे – 100% जू़म, 

Page Width जू़म, Multiple Page Zoom आदद। 
 

 

 Zoom - इस पर click करिे पर आपको option ममलता है क  आप MS word के पेज को फकतिें  
percentage तक zoom in करिा ीाहते हैं, अपिे अिुसार percentage Set कर ok करे  आपका 
MS word का पेज उतिा zoom in हो जाएगा। 

 100% - आपिे अपिे MS word के के पेज को ीाहे फकतिा ही ज्यादा zoom in कर ददया हो या 
zoom out कर ददया हो , इस पर जिलक करते ही आपके MS word का पेज वापस 100% mode 

यािी क  normal mode में आ जाता है। 
 One page - इस पर click करते ही आपके MS word का पेज 1 पेज के आकर का ददखिे लगेगा 

वापस normal करिे के मलए आप 100% वाले कमांड का उपयोग करें। 
 Multiple Page - इस पर click करते ही आपके MS word का पेज 1 पेज के आकर का ददखिे 

लगेगा वापस normal करिे के मलए आप 100% वाले कमांड का उपयोग करें। 
 Page width - इस पर भी click करिे पर आपके MS word के पेज क  ीौडाई बढ़ जात है। 
 



 

4. Window: - MS word में िए ववडंो को open कर सकते हैं और उसे एडडट कर सकते हैं। 
 

 

 New Window – इस Option के द्वारा एक िई ववडंो इन्सटय क  जा सकती है। 
 Arrange All – इस Option के द्वारा एक से अधधक Window को Vertically या Horizontally 

व्यवजस्प्थत फकया जा सकता है। 
 Split – इस Option के द्वारा फकसी Window को दो भाग  मे तोडा जा सकता है। 
 View Side By Side – इस Option के द्वारा दो Window को Side By Side रखकर उिक  

जािकाररय  को देखा जा सकता है। 
 Switch Window – इस Option के द्वारा फकसी ऐजिटव Window को अन्य ववडंो के साथ 

Switch फकया जा सकता है। 

Macros: - MS word के पेज पर क  गयी गनतववधधय  को record करिे का कायय करते हैं। 
 

 

 

 

 Macros - यदद आप ीाहते हैं क  हम जो भी MS word के पेज पर मलखिे / design बिािे का कायय 
कर रहे हैं, वो सब record हो जाए तो उसके मलए सबसे पहले आप इस command पर click कर 
Record Macro... पर click करें और कोई िाम मलखकर ok दबाये। इतिा करते ही आपका recording 

start हो जाता है, अब आपका कायय खत्म होिे के बाद आप वापस इसी command पर click कर 
Stop recording पर click करें, इतिा करते ही आपका फकया गया कायय सेव हो जाएगा। अब आप पुरे 
पेज को clear कर दे और वापस इसी कमांड पर click  कर View Macros पर click  करें और 
अपिा recorded name को सेलेिट कर Run बटि को दबाये . इतिा करते ही आपके द्वारा फकया 
गया कायय automatic MS word के पेज पर ीलिे लगेगा। 
 

MS Word All Menu Complete 
 

 



 

Shortcut Keys Effect 

1. Ctrl + A Selects all text in the document 

2. Ctrl + B Text bold 

3. Ctrl + C Copies selected text or images to the clipboard 

4. 
Ctrl + V 

Pastes copied text or images from the 

clipboard 

5. Ctrl + X  Cuts selected text or images 

6. Ctrl + P Prints the document 

7. Ctrl + S Saves the document 

8. Ctrl + N Creates a new document 

9. Ctrl + F Opens the Find command 

10. Ctrl + H Opens the Replace command 

11. Ctrl + I Makes text italic 

12. Ctrl + U Underlines text 

13. 
Ctrl + E 

Centers the line of text where the cursor is 

located 

14. Ctrl + L Left aligns text 

15. Ctrl + R Right aligns text 

16. Ctrl + M  Indents text 

17. Ctrl + Shift + L Creates a bulleted list 

18. Ctrl + K Insert Hyperlink 

19. Ctrl + O Opens a document 



 

20. Ctrl + End Go to End of Document 

21. Ctrl + Home Moves the cursor to the beginning of the 

document 

22. Ctrl + Left Arrow Moves the cursor one word to the left 

23. Ctrl + Right Arrow Moves the cursor one word to the right 

24. Ctrl+ Up Arrow Move the cursor up by one paragraph. 

25. Ctrl + Down Arrow  Move the cursor down by one paragraph 

26. F7 Check Spelling 

28. Shift+F7 Thesaurus 

29. Ctrl+2 Print Preview 

30. Ctrl + W Closes the active window or application 

31. Ctrl + Y Redoes the previous action 

32. Ctrl + Z Undoes the last action 

33. Ctrl + F4 Close the active document 

34. Ctrl +Enter Insert page break 

35. Shift + Enter Insert line break without breaking paragraph 

36. Enter Insert paragraph break 

37. Ctrl + Shift + Enter Insert column break (break table) 

38. Alt + Ctrl + M Insert a comment 

39. Ctrl + Shift + G Open the Word Counting dialog box. 

40. ESC Close print preview 



 

 

It takes a lot of hard work to make notes, so if you can pay some 

fee 50, 100, 200 rupees which you think is reasonable, if you are 

able to Thank you... 

नोट्स बनाने में बहुत मेहनत  लगी है , इसललए यलि आप कुछ शुल्क 50,100, 200 

रूपए जो आपको उलित लगता है Pay कर सकते है, अगर आप सक्षम है तो, 

धन्यवाि । 

41. Alt+Shift+D Insert current Date Field 

42. Alt+Shift+P Insert Page Number Field 

43. Alt+Shift+t Insert current Time Field 

44. Alt+Shift+K Preview a mail merge 

45. Ctrl+T Increase hanging indent 

46. Ctrl+Shift+T Decrease hanging indent 

47. Ctrl+1 Set line-spacing to single-space 

48. Ctrl+2 Set line-spacing to double-space 

49 Ctrl+5 Set line-spacing to 1.5 

50. Alt+Ctrl+1 Apply Heading 1 style 

51. Alt+Ctrl+2 Apply Heading 2 style 

52. Alt+Ctrl+3 Apply Heading 3 style 

53 Ctrl+F1 Show or hide the ribbon 

54 Shift+End Select current table cell 

55 Ctrl+Shift+O Switch to Outline View 



 

 

 

 

 

 

 



 

 

 

 

www.upcissprime.com 

Upciss Prime 

Our Computer Course 

CCC, ADCA, Tally Prime, 

HTML, CSS, Internet, 

MS Office, O-level 

YouTube Channel – Upciss Prime 

 

 

Upciss Computer Education एक सबसे बडा Online और Offline मशक्षर् संस्प्थाि है 

यहां पर आप कंलयूटर स ेसंबंधधत सभी प्रकार के PDF notes बबल्कुल free में प्रालत कर 

सकते हो जैसे - NIELIT CCC, NIELIT O-Level, ADCA (Advanced Diploma in Computer 

Application), Tally Prime, Internet, All Keyboard Shortcut, MS Office इि सभी 

Courses के PDF Notes बबल्कुल फ्र  में हमारी website (https://upcissprime.com,  स े

download कर सकते हो। 

 

https://www.youtube.com/@upcissprime
https://www.youtube.com/@upcissprime
https://upcissprime.com,/

